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PREFACE

Book Conventions

The following table illustrates and explains conventions used in writing about MEDUSA applica-

tions.

Convention Example Explanation

Menu Choose Zoom from the View menu Indicates a command, function or
Add button button that you can choose from a
Choose the tool Creates thin solid lines. menu, dialog or tooltray.

Syntax acos 0.345 User input,
The ciaddobj command commands, keywords and
Return or Control-g keys to press on a keyboard.

SyntaxBold Enter command> plot_config Where system output and user input

are mixed, user input is in bold.

Syntaxltalic

tar -cvf /dev/rst0 filename

Supply an appropriate substitute for

each variable; for the given example
replace filename with an actual file
name.

Filename&path

medusa\med2d\m2d\src\

Shows path and filenames.

UPPERCASE MEDUSA or CADCONVERT Names of products.

italic left mouse button Indicates the buttons to press on a
Drafting User Guide mouse and names of books.

bold A temporary group is a collection of ... | Emphasize text.

Please note: lllustrations showing menus and forms are taken from a window system.
The display for other platforms can differ slightly.
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Online User Documentation (HTML)

Online documentation for each book is provided in HTML format. You can view this online
documentation in the MEDUSA installation directoryand directly by calling it up within the
MEDUSA user interface.

Installation Directory

1. Navigate to the directory where MEDUSA is installed.
<MEDUSA installation directory>/meddoc/doc/<language>/ (Unix)
<MEDUSA installation directory>\meddoc\doc\<language>\ (Windows)
where <language> is either english, german or french.

2. Click on the file mainmenu.htm.

3. Click the book title you want to view.

MEDUSA Interface

1. Click left on the entry Help inside the main menu.

2. Choose MEDUSA Documentation from the pulldown menu.
A browser opens showing the mainmenu.htm listing all available documents.

Printing Version of the Documentation (PDF)

A PDF (Portable Document Format) file is included for each online book. You must have

Acrobat Reader installed to view and print PDF files. If you don‘t have the Acrobat Reader, you

can download it for free from the Adobe homepage:
http://www.adobe.com/products/acrobat/readstep.html

In order to search for a keyword across PDF files you can use Acrobat Reader. Therefor
Acrobat Reader Version 6.0 or higher has to be installed. The Reader provides a multiple
search function, i.e. you can specify complete directories containing several PDF files for
searching.

6 © CAD Schroer GmbH
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INTRODUCTION AND START

Introduction

The CADConvert program builds the base for the MEDUSA-DXF/DWG interface. The converter
enables 2D MEDUSA-drawings to be converted into DXF/DWG-data and vice versa. Therefore
the program can be used in four ways:

MEDDXEF : Translates 2D MEDUSA-sheets to DXF-data
DXFMED : Translates DXF-data to 2D MEDUSA-Sheets
MEDDWG : Translates 2D MEDUSA-sheets to DWG-data
DWGMED : Translates DWG-data to 2D MEDUSA-Sheets

DXF/DWG-data not produced by AutoCAD may not meet the DXF/DWG-standard and can
produce unexpected results. The converter has been developed fault tolerant to read in non
DXF/DWG-standard files but it is not able to compensate all deviations.

In some cases MEDUSA and AutoCAD work completely different, making it impossible to
regenerate the same data using a loop-translation (e.g. MEDUSA-DXF-MEDUSA or DXF-
MEDUSA-DXF). The converter is designed in a way to cover the properties of the target
system. For loop-translation following has to be considered:

MEDUSA line and text types are maintained during an export/import cycle.

If lines or texts with free style are exported into AutoCAD and then re-imported into
MEDUSA, they will be free styles again having the appropriate line or text type
exported before, unless the type was explicitely mapped onto another MEDUSA style
during import.

Standard prims of MEDUSA are maintained during an export/import cycle.

Standard prims are exported to AutoCAD as blocks and they are re-imported as
MEDUSA prims again (in earlier revisions prims changed into groups with graphic
elements). This is not valid for user defined prims. For mapping of prims see
“Configuration”, “Default Mapping DXFMed/DWGMed"“Symbol Mapping” on page 29.

URL text properties are exported to DXF/DWG and also imported back into MEDUSA.

© CAD Schroer GmbH
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Starting CADConvert

CADConvert can be started within MEDUTIL, within MEDUSA and offline.

Running CADConvert within MEDUTIL

You can start CADConvert from within MEDUTIL using the commands listed below for the
appropriate interface.

Command Called Interface
meddxf MEDUSA to DXF
dxfmed DXF to MEDUSA
meddwg MEDUSA to DWG
dwgmed DWG to MEDUSA

Using CADConvert within MEDUSA

The interfaces mentioned in “Running CADConvert within MEDUTIL” can be called within the
MEDUSA user interface with the functions File -> Open and File -> Save as and then choosing the
extension of the AutoCAD file.

Starting Offline inside a Console

Please note: The following explanations are valid for a Windows system.
It is similar on a UNIX system. You only have to use the usual path conventions
(slash / instead of backslash \) and the executable is cadconvert instead of
cadconvert.exe.

For starting CADConvert offline inside a console (DOS box) do the following steps:
1. Open a console (DOS box).
2. Inside the console start the login.bat from your user project.
3. Then type in the command:

8 © CAD Schroer GmbH
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<inst-dir>\CADCONVERT\M2D\RUN\cadconvert.exe @e- macro <macro name>
where

<inst-dir> is the installation directory of MEDUSA.

<macro name> is a text file with commands which shall be done by CADConvert.
Example for a CADConvert macro converting MEDUSA files into ACAD DWG format:

@e- meddxf --————————————— direction of conversion
@e- modin med --—-————————- input format
@e- modout dwg -—--—-—---—-- output format

@e- reset E:\medusal\cadconvert\cfg\cadconvert.cfg
@e- BLOCKNAME Off

.- -(some more parameter settings)

@e- SHEETSIZE BYGEOMETRY

@e- UNITS MM

@e- in "E:\user_prj\med_to_convert\z_001.she"

@e- out "E:\user_prj\converted to dwg\z_ 001.dwg"
@e- go

You also can do the steps for running the login.bat and starting CADConvert in a Batch file,
which then looks like following:

call E:\user_proj\login.bat
E:\medusa\CADCONVERT\M2D\RUN\cadconvert.exe @e-
macro E:\user_proj\med_dwg.mac

List Conversion

You can convert automatically several files, which are compiled in a list, using one command.

1. Create a directory and insert any files, which should be converted. In our example the
directory is called sheet_dir. It contains MEDUSA sheets with file extension she.

2. To create the list automatically open a console (DOS box) and type in the following:
dir /s /b E:\sheet_dir\*.she > E:\sheet_dir\list.txt
The list file, here called list.txt, is inserted into the specifyed directory, E:\sheet_dir. It
contains all files of the E:\sheet_dir directory with extension .she.

In section “Starting Offline inside a Console” on page 8 the example of a macro is given, which
converts a MEDUSA file into DWG format. For the list conversion in our example the macro
convert_meddwg.mac has been created in the directory E:\userproj. It looks like as follows:

@e- meddxf
@e- modin med

© CAD Schroer GmbH 9
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@e- modout dwg

@e- reset E:\medusa\cadconvert\cfg\cadconvert.cfg
@e- list E:\sheet_dir\list._txt

@e- go

@e- quit

The batch file, convertjob.bat, used for running the login.bat and starting CADConvert, looks for
the list conversion as follows:

call E:\user_proj\login.bat
E:\medusa\CADCONVERT\M2D\RUN\cadconvert.exe @e-
macro E:\user_proj\convert_meddwg.mac

10 © CAD Schroer GmbH
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CONFIGURATION

This chapter explains all the configuration and mapping files used by CADConvert.

® SBUINGS oo eiiiiee e 12
» Settings - Graphical User Interface..........cccoceeeeeeeeiiiieeieeeiiinnnnns 15
® TIUE COlOT ..t 18
* Font Names - FONt NUMDErS ..., 19
o Character Mapping ....cccuueeuemiiiiiiieiiieieee e 20
» Default Mapping DXFMed/DWGMed.............ooooeiiiiiiniininnnnne, 21
* Default Mapping MedDXF/MedDWG...........ceeeeeeeeeeeeeeiieeiiinnns 32
» Default Mapping - Graphical User Interface............cccccccvvennnnn. 40
® MEASLYIE.....eee e 44
« Changing the Configuration via User Interface........................ 45
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Settings

By default the settings for CADConvert, which are transferred to the graphic user interface, are
made in one of the following files (depending on the language):

» English: <medusa>\cadconvert\cfg\cadconvert.cfg

» German: <medusa>\medchangeger\cadconvert\cfg\cadconvert.cfg
* French: <medusa>\medchangefra\cadconvert\cfg\cadconvert.cfg
» Japanese: <medusa>\medchangeja\cadconvert\cfg\cadconvert.cfg

Further more it is possible to use another directory containing the configuration file than the
default directory. This can be done by setting the environment variable
CADCONVERT_CUSTOM=e:\customer\<xyz>. The value of the variable has to be a valid
directory, which contains the cadconvert.cfg file at minimum. If the directory is invalid or the
cadconvert.cfg file does not exist, the following error message is displayed:
Setting from CADCONVERT_CUSTOM environment variable ignored, because
specified directory or file cadconvert.cfg doesn’t exist!

It follows an example of the cadconvert.cfg file. Keywords are described in the chapter “List of
Commands” on page 49.

Which mapping file is used for the conversion is described in the entries to Linestyle and
Textstyle Mapping. Mapping files are explained in the chapters “Default Mapping DXFMed/
DWGMed” on page 21 and “Default Mapping MedDXF/MedDWG” on page 32.

Configuration file for CADConvert

-- General CADConvert Settings

HELPPATH = ${CADCONVERTH\help\ger
MAPLOG = off

MAPFILE = cadconvert.map

ERRLOG = off

ERRFILE = cadconvert.err

-- MEDUSA Settings

PROJECT = ${MED_PROJ}

CODEPATH = ${MED_PROJ}\m2d\bin\code.bin
DDLPATH = ${MED_PROJ}\med\bin\ddl _bin
PRIMPATH = ${MED_PROJ}\m2d\bin\prims.bin

-- Linestyle Mapping
MEDDXF_LINESTYLE_MAP
DXFMED_L INESTYLE_MAP

${CADCONVERT}\cfg\med2dxf_Istyle.map
${CADCONVERT}\cfg\dxf2med_Istyle.map

-- Textstyle Mapping
MEDDXF_TEXTSTYLE_MAP

${CADCONVERT}\cfg\med2dxf_tstyle.map

12 © CAD Schroer GmbH
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DXFMED_TEXTSTYLE_|
MEDMED_TEXTSTYLE_

MAP
MAP

-- Symbol (Prim) Mapping
-- SYMBOLMAP = ${CADCONVERT}\cTg\dxf2med_symbol .map

-— DXF Point Mapping
--POINTMAP = ${CADCONVERT}\cfg\dxf2med_point.map

-— Layerstatus Mapping
—-- MEDDXF_LAYERSTAT_MAP = ${CADCONVERT}\cfg\med2dxf_layerstatus.map

-- MEDUSA Stylefile

STYLEPATH
COLOURPATH
BOLDNESSPATH

-- MEDUSA -> DXF
MEDDXF_DIMENS10ON
BLOCKS

CLUMPNAME

COLORS

POLYLINE

MEDTEXT
MEDTEXT_GDT
DXFPRECISION
MEDCODE

UNSCALE
SPECTEXT_AS_PIC
SUPERL INEMODE
TEXTBOX
TEXTHEIGHT_ZERO
LTSCALE

PM5

ACADVERSION

-— BIGFONT
DXFOUT_CHARSET

-— DXF -> MEDUSA
DXFMED_DIMENSION
MOVE

CLUMPS

BLOCKNAME

UNITS

SCALE
MEDPRECISION
SHEETSIZE
FILLGAP

${MED_PROJ}\m2d\bin\styles.xml
${M2D_PROD}\m2d\src\colours._map
${MED_PROJ}\m2d\bin\boldness.map

%
@
~+
-
=)
«Q
%

DIM

ON

ON

ON

ON
medtext
medtext

9

1

OFF

OFF

LINE

OFF

OFF

12

ON
ACAD2000
= BIGFONT.SHX
ANSI1 1252

Settings
COM

on

on

off

MM

1.0

HIGH
BYDXFFILE
= 0.1

${CADCONVERT}\cfg\dxf2med_tstyle.map
${CADCONVERT}\cfg\med2med_tstyle._map

© CAD Schroer GmbH
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CONVSPACE
CONVSPACE
HIDDENLAYER

LINEWEIGHT_DEFAULT

PROXY
SPLINEAPPROX
DXFIN_CHARSET
FORCE_DXFIN_CS
XREF

USETRUECOLOR
OVERWRITE

MODEL
ALL_PAPER
on

0.0

BLOCK
CONIC
ANSI1_1252
OFF

I o o

T T
om T
=

14
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Settings - Graphical User Interface

Settings for the conversion of MEDUSA to AutoCAD and vice versa respectively can also be
made inside the graphical user interface of MEDUSA by using the Options DXF/DWG-Interface
dialog.

Please note: Modifications, which you make in this dialog and confirm them with OK, are only
active during this work session. With a restart the settings are taken from the
cadconvert.cfg file (see “Settings” on page 12). Since the cadconvert.cfg will be not
overwritten automatically, MEDUSA reverts to the last saved settings of the file.
I.e. If you want to change settings permanently, you have to change them in the
cadconvert.cfg.

Choose the entry options from the main menu and then Interfaces > DXF/DWG.

Figure 1 The Interfaces Pulldown Menu

Options [ Utilities Bacis1! Windows Licenses Help
Defaults ... ® O & ||EE|

| Interfaces ’ OxF /DG
Admin Mode DXF/DWWG Mapping Tables
Configuration 8 DXF/DVYG Config Path

The dialog Options DXF/DWG-Interface opens. It contains two different tabs.

The first tab provides the settings for the conversion from MEDUSA to DXF/DWG.

© CAD Schroer GmbH 15
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Figure 2 Dialog DXF/DWG Interface: Tab MEDUSA -> DXF/DWG
| =|o] x|
MEDUSAS -= DEF/IWVG | DRF/DWGE -> MEDLSAL |
Keyward alue
ACADNVERSION ACADZO00 j
BIGFONT
BLOCKS On
CLUMPMAKME Cn
COLORS On
DHFOUT CHARSET ANSI 1282 j
DHEFPREECISION g
LTSCALE 12
MEDCODE 1
MEDDXF _DIMENSION ® DM O GED
MEDTEST medtext
MEDTEXT GOT medtext
POLYLINE Cn
SFECTEXT AS PIC [1on
SUPERLINEMODE @® Line © Graphic O Bath
TEXTBOX []0n
TEXTHEIGHT fFERO [1on
LINSCALE [1on
LUSETRUECOLOR [1on
<instalipath=\cadconvert\cfglcadconvert. ofy
024 | Cancel | Reset | ﬂl

OK
Assumes modified settings for the duration of the work session.

Cancel
Changes are not assumed. The last specified settings, which have been approved
with OK are active.

Reset

Takes the default settings from the cadconvert.cfg file.

The second tab contains the settings for the conversion from DXF/DWG t0 MEDUSA.

16 © CAD Schroer GmbH
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Figure 3

MEDLUS AL -= DEFDWIG

Dialog DXF/DWG Interface: Tab DXF/DWG -> MEDUSA

| =13l x|

DXF/DWG - MEDUSAL |

Keyward alue
BLOCKMAME [] On
CLUMPS On
CONYSPACE ® Madel O Paper

DXFIN_CHARSET
DXFMED_DIMENSION
FILLGAP
FORCE_DXFIN_CS
HIDDENLAYER
LINEWEIGHT DEFAULT
MEDPRECISION
MOWVE

PROXY

SCALE

SHEETSIZE
SPLINEAPPROX
UNITS
USETRUECOLOR
¥REF

EEREZE

® com O DI O GED

0.1 |
] On

On

0.0 |
O Low © Mediom @ High

On
® Block O Entity O Off

|AUTO |
® ByDxFFile O ByGeometry
) Linear ® Conic

® mht O INCH

[]On
[ ]On

<nstalipath=\cadconverticfyicadconvert. cfy

DIk | Cancel | Reset |

Help |

The functions of the buttons comply with the ones described on the previous page.

Keywords inside the dialogs are described in the chapter “List of Commands” on page 49.

© CAD Schroer GmbH
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True Color

Since AutoCAD 2004 it is possible to define True Colors for elements.

Usually AutoCAD has 256 base colors, the so called AutoCAD-Color-Index (ACI), which are
defined as RGB values. However since AutoCAD 2004 an additional True Color can be defined,
which can have any RGB value from the whole color palette of 16,7 million colors. If existent,
the True Color value is leading against the ACI color value.

During conversion for both directions, import and export, the option USETRUECOLOR can be
set in order to transfer these True Color values. For example, if you export a MEDUSA drawing,
after an import of the drawing as a DXF or DWG file the same colors as before will be displayed
in MEDUSA. If the option USETRUECOLOR is off, the ACI color value will be used.

DXF/DWG -> MEDUSA

When importing from AutoCAD, the True Color is taken, if it was defined in AutoCAD. If there is
no color with appropriate RGB values in MEDUSA, the color will be added to the MEDUSA color
catalog. If there is an appropriate value, the color existing in MEDUSA will be used. MEDUSA

can manage 256 colors. If this amount is exceeded, that color will be taken which matches best.

MEDUSA -> DXF/DWG

When exporting, an AutoCAD file with RGB values will be written, if the option
USETRUECOLOR is switched on. This will be not done, if the MEDUSA color comes close to
an ACI color, then this one will be taken.

Mapping

Instead of a color number an RGB value can be defined for a True Color in the column Colour
of the mapping table, if a certain True Color is to be mapped. This is possible for input and
output.

Syntax: RGB 247, 111, 17
True Color values are handled in the same way as usual color values.

Details on the mapping is given in “Default Mapping DXFMed/DWGMed” on page 21 and
“Default Mapping MedDXF/MedDWG” on page 32.

18 © CAD Schroer GmbH
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Font Names - Font Numbers

Inside the graphical user interface MEDUSA uses font names instead of font numbers, which
are used internally only. CADConvert needs font numbers for mapping. The assignment of font
names to font numbers is done in the code.dat file which is located in the directory
med2d\m2d\src.

Font assignment has the following syntax:
FONT <no> <name>

where
<no>
is an integer number

<name>
is the font name

If you want to define a certain font for mapping on the site of MEDUSA look into the directory
med2d\m2d\src either at the code.dat file or the font.map file for the number of a certain font name.

Details on font assignments are given in the MEDUSA Customization Guide, chapter ,Decortext
Fonts“, ,Numbering Fonts*.

Example for some font assignments in code.dat:

—— The FONT vector

-- The FONT vector associates the font number attribute of Decortext
-- with a font name

Font 1 ARIAL_DEFAULT

Font 2 ARIAL FILL DEFAULT
Font 3 EXPRESS

Font 4 GOTHIC

Font 5 HAND

Font 6 LEROY

Font 7 PICA

© CAD Schroer GmbH 19
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Character Mapping

MEDUSA and DXF/DWG allow the use of special characters that cannot be represented using
the standard font set. The special characters can be mapped using the mapping table
character.map located in the subdirectory cfg.

File Syntax:
-- Text Mapping MEDUSA --> Autodesk DXF

CSGConvType : CSGMed42Dxf
CSGMappingType : CSGTextMapping

<MEDUSA-Special Character> : <MEDUSA-Special Character>
<character string> : <character string>

Please note: The first two entries are internal keywords which specify the kind of file.
You may not change these entries.

In the first column of the next line the MEDUSA special character is included and in the second
column the DXF/DWG special character is included. The columns are separated by a colon.
The following is an example the first lines of the attached file.

-- Text Mapping MEDUSA --> Autodesk DXF

CSGConvType : CSGMed42DxF
CSGMappingType : CSGTextMapping

-- Prim

@pmfl - %%146
@pmf2 - %%147
@pmF3 - %%148
@pmF4 - %%149

The file delivered with the software includes the common MEDUSA special characters and the
corresponding (AutoCAD) DXF/DWG special characters defined in the medtext font-file. You
can change and extend the character mapfile. To get the correct result within AutoCAD, get the
online parameter MEDTEXT to medtext so that the medtext font-file is used within AutoCAD.
Furthermore the files medtxt.shx and medtxt_gdt.shx have to be integrated into the AutoCAD font
directory.

Character mapping is leading. If a corresponding entry cannot be found in this table for a
special character, the internal default mapping will be performed.

20 © CAD Schroer GmbH
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Default Mapping DXFMed/DWGMed

General Practice

Basically lines and texts are converted from AutoCAD into MEDUSA in that way, that the same
style names are used. If no appropriate MEDUSA style name is found for a AutoCAD style
name, conversion is performed according to the definition in the appropriate mapping table (see
“Line Style Mapping” on page 22 and “Text Style Mapping” on page 26).

Layers are numbered in sequence as they appear in the DXF/DWG-file. The numbering starts
using the baselayer that can be set in dxf2med_Istyle.cfg located in subdirectory cfg. The states of
a layer (invis, frozen,...) are not taken into account.

The mapping of dimension elements is possible. The dimension graphics will be treated as
normal graphics with one exception, the text and line types remain as TDM and LDM.

Attributes

DXF/DWG-attributes can be visible, invisible, constant or variable. In MEDUSA all attributes are
translated as text attributes and added to the respective structure. To be consistent with the
MEDUSA naming conventions, the attribute names are stripped to 6 characters. If the
converted name already exists, a figure is appended to the name until a unique name is found.

If for example the attributes NUMBER_A, NUMBER_B and NUMBER__C are used within the
DXF-file, then CADConvert changes NUMBER_A to NUMBER, NUMBER_B to NUMBEL1 and
NUMBER_C to NUMBE2.

Hints for Mapping

Properties which are locked in the MEDUSA style are not taken from the mapping.
Mapping does not create new styles.

For color of lines numbers are used on the side of MEDUSA. These numbers represent a
certain coloring. The assignment of numbers to properties can be found in the file:
<installation path MEDUSA>\med2d\m2d\src\colours.map

© CAD Schroer GmbH 21
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Line Style Mapping

Differing from standard and in dependency of name, layer and color, DXF lines can be assigned
to a defined MEDUSA line with a defined layer.

This can be done with the file dxf2med_lIstyle.map in the subdirectory cfg.

File Syntax

-- Linestyle Mapping Autodesk DXF --> MEDUSA
CSGCONVTYPE : CSGDXF2MED4

CSGMAPPINGTYPE : CSGLINESTYLEMAPPING
CSGBASELAYER ~ : <int>

-- AutoCAD > MEDUSA

-- LineStyle : Layer : Colour : Bold : LineStyle : Layer : Colour : LineType : Bold : Transfer :

------------- o
<str>  Do<str> I <int> <re> @ <str> o <int> D<int> @o<str> <re>: 1/2

Please note: The first two entries are internal keywords which specify the kind of file.
You may not change these entries.

The line style mapping file has the following main definitions:
* CSGCONVTYPE marks the conversion type and is CSGDXF2MED4.

» CSGMAPPINGTYPE marks the mapping type. For line mapping it is
CSGLINESTYLEMAPPING.

» CSGBASELAYER is the number of the basis layer, e.g. 500. This entry is optional.

Below the main definitions you find a table. On the left hand side the columns for AutoCAD line
definitions are given, which are mapped to the MEDUSA line styles on the right.

The columns for AutoCAD definitions are:
 LineStyle gives lines by names (e.g. contour).
» Layer gives layers by names (e.g. dimension).

» Colour gives colors by the color numbers (e.g. 2) or True Color RGB values (e.g.
RGB 247,111,17).

» Bold gives boldness by thickness values (e.g. 0.18).
You can also define an area for boldness in the column (e.g. 0.18-2.5).

The columns for MEDUSA definitions are:
* LineStyle isthe name of a MEDUSA style (e.g. solid_thick).
* Layer gives layers by numbers (e.g. 11)

» Colour gives colors by color numbers (e.g. 1) or True Color RGB values (e.g. RGB
247,111,17).
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* LineType gives lines by its internal names (e.g. LO). LineType is always associated
with the MEDUSA LineStyle and therefore it matters for the Free Line Style only.

 Bold gives boldness by thickness values (e.g. 0.18).

Global setting:
« Transfer can be 1 for transferring elements and 2 for no transfer.

You can insert the following value types into the columns:

<str> = string

<int> =integer

<re> =real

< > = no entry. Any table cell can be empty. If a cell in the input section (DXF/DWG) is
empty, it matches any property of a DXF element. If a cell in the output section
(MEDUSA) is empty, it is filled during the scan, or, if scanning is finished, the default
value is inserted.

The following special values can be set in the MEDUSA section:

@FRE creates a Free Line Style which is characterized in that way that it has no name. This
keyword can be set for LineStyle only.

@SRC states that the input value is used also in the output. If there is no equivalent value in
MEDUSA, the closest value is used. If you use @SRC for LineStyle and if there is no
equivalent value in MEDUSA, the following styles will be generated:

» acad_solid for solid lines,

« acad_center for center lines,

* acad_dashed_short for dashed lines (with comparable stroke/gap sequence to
MEDUSA's dashed short line style),

» acad_dashed_long for dashed lines (with comparable stroke/gap sequence to
MEDUSA's dashed long line style), and

» acad_phantom for phantom lines.

@NUM defines that the output uses the same number as the input. For color, this can lead to a
different color in AutoCAD and MEDUSA depending on the definitions inside the color
map. @NUM can be set for Layer and Colour only.

@DEF defines that the output uses the default value. The result of scanning is not taken into
account.

Columns are separated by colons. You can comment out a column with two dashes (--).

A mapping table should be structured in that way, that on top of the table the special line types
are defined and in the bottom the common definitions are given. This is because scanning the
table is done from top to bottom (see "Mapping Procedure” below).
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Mapping Procedure

CADConvert determines all qualities of a DXF/DWG element and puts them into an imaginary
table. The table is scanned from top to bottom and from left to right, and each entry is evaluated
for matching with a table entry inside the mapping table (see “Example” on page 24).

A DXF/DWG element table entry matches with a mapping table entry, if the elements quality is
the same or if the mapping table has an empty table cell.

Once a DXF/DWG element table entry matches with a mapping table entry, the appropriate
MEDUSA definitions are used. Characteristics that are not explicitly mapped are set to the
default but they can be overwritten in the following scan, they are not occupied.

Several lines of the mapping table can match the properties of the DXF/DWG input element.
Note that already set MEDUSA definitions are not overwritten. Only those MEDUSA settings
can be overwritten which still have default values meaning that they are not occupied.

If all input DXF/DWG qualities are found in the mapping table or if all entries of the mapping
table were checked, then scanning is finished for the current DXF/DWG element and the next
one is evaluated.

Please note: Mapping does not create new MEDUSA line styles.
Mapping can be done on existing MEDUSA styles only.
Properties are only taken if they are not protected inside the MEDUSA style.

Example

The table below gives the mapping used for this example:

--AutoCAD > MEDUSA

--LineStyle: Layer : Colour: Bold :LineStyle : Layer : Colour: LineType : Bold : Transfer :

----------- S ST TN T S S ST S N S ——
dimension: : : : 4 : 1

continious : : : :solid_thin D21 Lo 1

dashed : : : :dashed_short_thin: : L3 1
:machine : : : 256 : @DEF 1
tbasement : 6 : 64 @ANUM : |
:basement : 7 : 0.18 : I 60 : D@SRC - 1
thasement : 5 : : 58 : : : |
: : 1@FRE : : o L4 1
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The following table shows some DXF/DWG elements, one per line, on the left hand side. On the
right you see the resulting MEDUSA line styles, which are created according to the mapping
table given above.

AutoCAD MEDUSA

LineStyle Layer Color Bold LineStyle Layer | Color LineType | Bold
dotted dimension 5 0.5 Free Style 4 Default | L4 0
phantom dimension 3 0.5 Free Style 4 Default | L4 0
continuous | dimension (all) 0.5 solid_thin 4 Default | LO Default
continuous | (all, not 4) | (all) | 0.5 solid_thin 21 Default | LO Default
dashed machine (all) 0.2 dashed_short_thin | 256 Default | L3 Default
dashed basement 5 0.2 dashed_short_thin | 58 Default | L3 Default
dashed basement 6 0.2 dashed_short_thin | 64 6 L3 Default
dashed basement 7 0.18 dashed_short_thin | 60 Default | L3 0.18

The value Default in the table above stands for the appropriate default value of the MEDUSA
style, which always has defaults for layer, color, line type and boldness. In case of Free Style
boldness is set to zero, meaning minimum thickness.

In detail a DXF element is mapped like following, taking the last DXF/DWG element as
example. The input element is dashed basement 7 0.18.

1. CADConvert starts scanning through the mapping table looking for dashed in the 1st
row.
The first cell is empty, meaning that it matches. The second cell contains dimension
which does not match and CADConvert aborts evaluating this row.

2. CADConvert goes on looking for dashed in the 2nd row.
The first cell contains continuous, meaning no match and CADConvert goes on
scanning the next row.

3. CADConvert looks for dashed in row 3.
In this row dashed is found and now the other two table entries are evaluated. Both
are empty, meaning that also these entries match. Now CADConvert takes the defined
properties of the appropriate line style and writes the entries into the table.
At this time the MEDUSA style settings are:
dashed_short_thin Default Default L3 Default.
4. CADConvert goes on looking for dashed in the 4th row of the mapping table.
The left table entry is empty, meaning that it matches.
CADConvert looks for the 2nd table cell, basement, but it finds machi1ne, meaning no
match. Scanning this row is finished with that.
5. CADConvert goes on looking for dashed inside the next row (5).
Again the left table cell is empty, meaning that it matches.
a. CADConvert looks for basement in the 2nd cell.
Now basement is found and so it matches.
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b. The color 7 is looked up in the 3rd cell.
In this row the color is 6. So there is no match and CADConvert goes on scanning
the next row.

6. CADConvert looks for dashed in row 6 of the mapping table.

Again the first cell is empty (match).

a. The 2nd cell is basement (match).

b. The 3rd cell is 7 (match).

c. The 4th cell is 0.18 and so the whole line matches.
As in step 3 CADConvert takes the appropriate line style settings and writes the
entries into the table. This time only the layer number 60 is taken because all other
properties were already allocated in step 3. The MEDUSA settings are now:

dashed_short_thin 60 Default L3 0.18.
Because all input properties are evaluated, scanning for this DXF/DWG element is
finished.

Text Style Mapping

Differing from standard and in dependency of name, layer and color, DXF/DWG texts can be
assigned to defined MEDUSA texts with a defined MEDUSA text style, text type, font, layer,
color and boldness. This can be done with the file dxf2med_tstyle.map located in subdirectory cfg.

File Syntax

-- Textstyle Mapping AutoCAD -> MEDUSA
CSGCONVTYPE : CSGDXF2MED4
CSGMAPPINGTYPE : CSGTEXTSTYLEMAPPING
CSGBASELAYER = 500

--AutoCAD > MEDUSA
--TextStyle: FontFile: Layer: Color: Bold: TextStyle : Layer: Color: TextType: Font: Bold: Transfer:
----------- R SRR SR YU RIS R NI J R S SN SR ———
: 0.18:plain_large: > @DEF : : :0.5: 1
: : : :plain_large: > @SRC : : > @SRC: 1
<str> @ <str>  @o<str>: <int>i<rea>:  <str> I <int>: <int>: <str> <int>i<rea>: 1/ 2 :

Please note: The first two entries are internal keywords which specify the kind of file.
You may not change these entries.

The text style mapping file has the following main definitions:
» CSGCONVTYPE marks the conversion type and is CSGDXF2MEDA4.

* CSGMAPPINGTYPE marks the mapping type. For text mapping it is
CSGTEXTSTYLEMAPP ING.

* CSGBASELAYER is the number of the basis layer, e.g. 500. This entry is optional.
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Below the main definitions you find a table. On the left hand side the columns for AutoCAD line
definitions are given, which are mapped to the MEDUSA line styles on the right.

The columns for AutoCAD definitions are:
« TextStyle gives styles by names (e.g. hints).

« FontFile is afile name (e.g. ARIALBD.TTF). If you do not want to use True Type
fonts, the file medtext.shx is provided which is in the subdirectory font.

» Layer gives layers by names (e.g. dimension).

* Colour gives colors by the color numbers (e.g. 2) or True Color RGB values (e.g.
RGB 247,111,17).

» Bold gives boldness by thickness values (e.g. 0.18).
You can also define an area for boldness in the column (e.g. 0.18-2.5).

The columns for MEDUSA definitions are:

« TextStyle isthe name of a MEDUSA style (e.g. plain_large).

« Layer gives layers by numbers (e.g. 11)

e Colour gives colors by color numbers (e.g. 1) or True Color RGB values (e.g. RGB
247,111,17).

* TextType gives texts by its internal names (e.g. T1). TextType is always associated
with the MEDUSA TextStyle and therefore it matters for the Free Text Style only.

* Font gives the number of the font (e.g. 1).

» Bold gives boldness by thickness values (e.g. 0.18).

Global setting:
 Transfer can be 1 for transferring elements and 2 for no transfer.

You can insert the following value types into the columns:
<str> =string

<int> =integer

<rea> =real

< > =no entry. Any table cell can be empty. If a cell in the input section is empty, it matches
any property of a DXF element. If a cell in the output section is empty, it is filled during
the scan, or, if scanning is finished, the default value is inserted.

The following special values can be set in the MEDUSA section:

@FRE creates a Free Text Style which is characterized in that way that it has no name. This
keyword can be set for TextStyle only.

@SRC states that the input value is used also in the output. If there is no equivalent value in
MEDUSA, the closest value is used. If you use @SRC for TextStyle and if there is no
equivalent value in MEDUSA, the following styles will be generated:

* acad_ttf_text for all text elements with a True Type font, and

© CAD Schroer GmbH 27



MEDUSA, CADConvert -
Configuration (CAD)

CAD Schroer

 acad_plain_text for all other text elements.

@NUM  defines that the output uses the same number as the input. For color, this can lead to a
different color in AutoCAD and MEDUSA depending on the definitions inside the color
map. @NUM can be set for Layer and Colour only.

@DEF defines that the output uses the default value. The result of scanning is not taken into
account.

Columns are separated by colons.You can comment out a column with two dashes (--).

A mapping table should be structured in that way, that on top of the table the special text types
are defined and in the bottom the common definitions are given. This is because scanning the
table is done from top to bottom. For details on the mapping procedure see “Mapping
Procedure” on page 24.

Example

The table below gives the mapping table used for this example:

--AutoCAD : MEDUSA
--TextStyle: FontFile: Layer: Color: Bold: TextStyle : Layer: Color: TextType: Font: Bold: Transfer:
----------- T
examplel: itext : 0.18:plain_large : : @DEF : : :0.5: 1
: :com -7 0.2 :plain_large : : @SRC : : : BSRC: 1
hints : : : :plain_large : : : T : : 1
: title : : : D2 : : o1 1
company : : : : :plain_small : 17 : : Tm -1 : 1
number : : T4 zcircle 11 N 03] 1

The following table shows some DXF elements, one per line, on the left hand side. On the right
you see the resulting MEDUSA style, which is created according to the mapping table above.

AutoCAD MEDUSA

TextStyle Layer Color | Bold TextStyle Layer Color TextType Font Bold
examplel text 5 0.18 plain_large Default Default Default Default 0.5
examplel com 7 0.2 plain_large Default 7 Default Default 0.2
hints text 2 0.2 plain_large Default Default T1 Default Default
hints title 4 0.2 plain_large 2 Default T1 Default 1
company title | 2 0.2 plain_small 2 Default T1 1 1
company text 2 0.2 plain_small 17 Default T1 1 Default
number text 4 0.2 circle 11 Default TC1 Default Default
number text 5 0.2 Free Style Default Default Default Default 0

As you can see the last DXF element matches with no line of the mapping table and therefore
this element is assigned to the free style in MEDUSA.
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The value Default in the table above stands for the appropriate default value of the MEDUSA
style, which always has defaults for layer, color, line type and boldness. In case of Free Style
boldness is set to zero, meaning minimum thickness.

Special Text

For a clear definition of special texttypes (e.g. underlined text, text in a box, ...) a second
mapping table is recommended. This is the table med2med_tstyle.map located in the subdirectory
cfg.

The file is build up like:

-- Textstyle Autodesk DXF --> Mapping MEDUSA
CSGConvType : CSGMed2Med

CSGMappingType : CSGTextStyleMapping

-- ACAD  : MEDUSA
--Texttype: underlined : overlined : boxed : circle : sausage

<string> : <string> : <string> : <string> : <string> : <string>

The following table is delivered as a standard. You can change and extend it.

--Texttype: underlined : overlined : boxed : circle : sausage

DT1 DT2 DT1 : DT3 DT4 DTS
Tl TUl T1 : TR1 TC1 TS1
T2 TU2 T2 : TR2 TC2 TS2
T3 TU3 T3 : TR3 TC3 TS3

ST1 TUl Tl : TR1 TC1 TS1

ST2 TU2 T2 : TR2 TC2 TS2

ST3 TU3 T3 : TR3 TC3 TS3

Symbol Mapping

In MEDUSA you can have prims consisting of one or more line elements. When converting a
MEDUSA drawing into AutoCAD, prims are converted to blocks with a certain nomenclature.
For example, a prim PAP in MEDUSA gets the block name MEDPRIM_LAY6_PAP__ in AutoCAD,
if it is on layer 6, or MEDPRIM_LAY90_SUP_EAR_ is a superprim with picture EAR on layer 90.

To re-create prims or superprims from blocks in AutoCAD during the translation to MEDUSA,
there exists a mapping file dxfmed_symbol.map, containing the assignment of block names and
prims and superprims respectively. The path to the mapping file has to be set in the
configuration file cadconvert.cfg (see “Settings” on page 12).
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Example Table:

-- Symbol Mapping AutoCAD -> MEDUSA -—

CSGCONVTYPE : CSGDXF2MED4

CSGMAPPINGTYPE : CSGSYMBOLMAPPING

-— DXF-BLOCK : MEDUSA Prim : Superprim
___________________ e
MED*PRIM*PAP? : PAP :

MED*PRIM*EAR_ : EAR : SUP

The block names can contain wildcards. * stands for several signs and ? represents one sign.

Point Mapping

Points in AutoCAD are converted into Prims in MEDUSA.

The path to the mapping file has to be set in the configuration file cadconvert.cfg (see “Settings”
on page 12).

Example Table:

-- Point Mapping
--POINTMAP = ${CADCONVERT}\cfg\dxf2med_point.map

CSGCONVTYPE : CSGDXF2MED4
CSGMAPPINGTYPE : CSGPOINTMAPPING
-- DXF-Point No : MEDUSA Prim : Superprim
__________________ e
2 PAP
32 PAP
5 PAP
62 PAP
34 PAP
35 PAP
3 DTM

Raster Images

With the conversion, referenced raster images of a DXF/DWG file are transferred to MEDUSA.
Precondition for the import is, that the referenced image(s) is (are) located in the same directory
as the DXF/DWG file.

30
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With the conversion of raster images only rectangular clipping of images and rotation by steps

of 90 degrees is possible. Shearing is not transferred (see also chapter “Limitations” on
page 85).
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General Practice

Basically lines and texts are converted from MEDUSA to AutoCAD in that way, that the same
style names are used. If no appropriate AutoCAD style name is found for a MEDUSA style
name, conversion is performed according to the definition in the appropriate mapping table (see
“Line Style Mapping” on page 32 and “Text Mapping” on page 36).

If additional definitions of MEDUSA linestyles (STY >5, so called user-styles) in the MEDUSA
code-file are made, these definitions have also to be done in the file medstyle.cfg located in
subdirectory cfg. The syntax in this file is the same as in the MEDUSA code-file (see <install
path to MEDUSA>\med2d\m2d\src\code.dat).

Text height and text width are taken from the code-file definition. Using the online parameter
MEDTEXT, you can determine which font-file is used for the graphical representation in
AutoCAD.

During conversion the states of a layer (invis, frozen,...) are not taken into account. Therefor an
additional Layer Status Mapping can be used (see “Layer Status Mapping” on page 39).

Attributes

MEDUSA attributes are converted to constant hidden text attributes in DXF/DWG. Since there is
no way to attach attributes to single elements in DXF/DWG, only clump-linked MEDUSA
attributes can be converted.

Hints for Mapping

For color of lines numbers are used on the side of MEDUSA. These numbers represent a
certain coloring. The assignment of numbers to properties can be found in the file:
<installation path MEDUSA>\med2d\m2d\src\colours.map

Line Style Mapping

Differing from standard and in dependency of name and layer MEDUSA lines can be assigned
to defined DXF lines with defined layer, color and linestyle. This can be done with the file
med2dxf_Istyle.map located in subdirectory cfg.
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File Syntax

-- Linestyle Mapping MEDUSA -> AutoCAD --
CSGCONVTYPE : CSGMED42DXF

CSGMAPPINGTYPE : CSGLINESTYLEMAPPING
CSGBASELAYER  : 500

-- MEDUSA : AutoCAD

-- LineStyle : Layer : Color : LineType : Bold : LineStyle : Layer : Color : Bold : Transfer :

------------- e ey’
<str> D <int> D <int> @ <str> I<re> D <str> I <int> D <int> D <re>: 1/ 2

Please note: The first two entries are internal keywords which specify the kind of file.
You may not change these entries.

The line style mapping file has the following main definitions:
* CSGCONVTYPE marks the conversion type and is CSGMED42DXF.

* CSGMAPPINGTYPE marks the mapping type. For line mapping it is
CSGLINESTYLEMAPPING.

* CSGBASELAYER is the number of the basis layer, e.g. 500. This entry is optional.

Below the main definitions you find a table. On the left hand side the columns for AutoCAD line
definitions are given, which are mapped to the MEDUSA line styles on the right.

The columns for MEDUSA definitions are:
* LineStyle isthe name of a MEDUSA style (e.g. solid_thick).
* Layer gives layers by numbers (e.g. 11)

* Colour gives colors by color numbers (e.g. 1) or True Color RGB values (e.g. RGB
247,111,17).

* LineType gives lines by its internal names (e.g. L1). LineType is always associated
with the MEDUSA LineStyle and therefore it matters for the Free Line Style only.

 Bold gives boldness by thickness values (e.g. 0.18).

The columns for AutoCAD definitions are:
« LineStyle gives lines by names (e.g. contour).
e Layer gives layers by names (e.g. dimension).

e Colour gives colors by the color numbers (e.g. 2) or True Color RGB values (e.g.
RGB 247,111,17).

* Bold gives boldness by thickness values (e.g. 0.18).

Global setting:
« Transfer can be 1 for transferring elements and 2 for no transfer.

You can insert the following value types into the columns:
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<str> =string

<int> =integer

<re> =real

< > =no entry. Any table cell can be empty. If a cell in the input section is empty, it matches

any property of a MEDUSA element. If a cell in the output section is empty, it is filled
during the scan, or, if scanning is finished, the default value is inserted.

The following variables can be set in the MEDUSA section:

@FRE defines the Free Line Style which is characterized in that way that it has no name. This
keyword can be set for LineStyle only.

The following variables can be set in the AutoCAD section:

@SRC states that the input value is used also in the output. If there is no equivalent value
available in the output, the closest value is used.

@DEF defines that the output uses the default value. The result of scanning is not taken into
account.

@NUM can be set for Colour only. @NUM defines that the output uses the same color number
as the input. This can lead to a different color in AutoCAD and MEDUSA depending on
the definitions inside the color map.

@NAM  can be set for Colour only. @NAM instructs the converter to use the MEDUSA layer
label as AutoCAD layer name. If no label is defined, the naming convention is
Layer_<layer no>.

Columns are separated by colons.You can comment out a column with two dashes (--).

A mapping table should be structured in that way, that on top of the table the special line types
are defined and in the bottom the common definitions are given. This is because scanning the
table is done from top to bottom. For details on the mapping procedure see “Mapping
Procedure” on page 24.

Example

The following table is the mapping used for this example.

-- MEDUSA > AutoCAD

-- LineStyle : Layer : Color : LineType : Bold : LineStyle : Layer : Color : Bold : Transfer :
------------- S I R R S SRR S SRS SIS S ———

dotted thin : 11 : : L1 : :Continuous :boundery: 1

100 : : LO : :Continuous :shafts : : : 1

o 110 : LO : :Continuous :details : @NUM : @SRC : 1

: 1018 : : : : :hidden : 3 : : 1

: : : L1 : :Continuous : : 1

L2 : centre :centre : 4 1
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The table below gives some MEDUSA input elements on the left and the resulting AutoCAD
elements after conversion on the right. For the DXF output the closest possible DXF value is
calculated from the MEDUSA input value, given as best match (BM) in the table below.

MEDUSA AutoCAD

LineStyle Layer Color LineType Bold LineStyle Layer Color Bold
dotted_thin 11 2 L1 0.25 Continuous boundary BM BM
hidden_line 1018 2 L1 0.25 Continuous hidden 3 BM
dotted_thick 100 2 L1 1.0 Continuous 100 BM BM
hidden_line2 1018 2 L4 0.75 hidden_line2 hidden 3 BM
chain_thin 11 2 L2 0.25 Centre centre 4 BM
solid_thin 100 2 LO 0.25 Continuous shafts BM BM
solid_medium 110 2 LO 0.5 Continuous details 2 0.5
solid_medium 110 12 LO 0.75 Continuous details 12 0.75
solid_thick 11 2 LO 1.0 solid_thick 11 BM BM
dashed_short2 1 2 L3 0.75 dashed_short2 | 1 BM BM

Special Mappings

The line styles of the following special mappings are ,imaginary* line style for CADConvert.

They are used for the graphical translation of the elements Prim, Point function and Superline.
* Linestyle mapping for Prims

MEDUSA DXF
LineStyle Layer Color | Bold Layer Color Linestyle
LPRM 241 Surface

» Linestyle mapping for Point functions
MEDUSA DXF
LineStyle Layer Color | Bold Layer Color Linestyle
LFUN 0 FUNV

« Linestyle mapping for Superlines
MEDUSA DXF
LineStyle Layer Color Bold Layer Color Linestyle
LSUP 0 Superline
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» Linestyle mapping for the graphical part of, for example, boxed or underlined texts

MEDUSA DXF
LineStyle Layer Color Bold Layer Color Linestyle
LTXT 0 Textline

Text Mapping

Differing from standard and in dependency of text, font and layer MEDUSA texts can be
assigned to defined DXF texts with a defined DXF layer, color style and font. This can be done
with the file med2dxf_tstyle.map located in subdirectory cfg.

File Syntax

-- Textstyle Mapping MEDUSA -> AutoCAD --
CSGCONVTYPE - CSGMED42DXF
CSGMAPPINGTYPE : CSGTEXTSTYLEMAPPING
CSGBASELAYER = 500

-- MEDUSA : AutoCAD

-- TextStyle: Layer: Color: TextType: Font: Bold: TextStyle: Font: Layer: Color: Bold: Transfer:

------------ e —
<str> Do <int>: <int>: <str> <int>: <re>:  <str>  i<str>: <str>: <int>: <re>: 1/ 2

Please note: The first two entries are internal keywords which specify the kind of file.
You may not change these entries.

The text style mapping file has the following main definitions:
* CSGCONVTYPE marks the conversion type and is CSGMED42DXF.

* CSGMAPPINGTYPE marks the mapping type. For text mapping it is
CSGTEXTSTYLEMAPP ING.

* CSGBASELAYER is the number of the basis layer, e.g. 500. This entry is optional.

The columns for MEDUSA definitions are:
 TextStyle isthe name of a MEDUSA style (e.g. plain_large).
* Layer gives layers by numbers (e.g. 11)

* Colour gives colors by color numbers (e.g. 1) or True Color RGB values (e.g. RGB
247,111,17).

 TextType gives texts by its internal names (e.g. T1). TextType is always associated
with the MEDUSA TextStyle and therefore it matters for the Free Text Style only.

* Font is the number of the font (e.g. 1).
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» Bold gives boldness by thickness values (e.g. 0.18).

The columns for AutoCAD definitions are:
* TextStyle gives styles by names (e.g. hints).

* Font is a file name (e.g. ARIALBD.TTF). If you do not want to use True Type fonts,
the file medtext.shx is provided which is in the subdirectory font.

e Layer gives layers by names (e.g. dimension).

e Colour gives colors by the color numbers (e.g. 2) or True Color RGB values (e.g.
RGB 247,111,17).

* Bold gives boldness by thickness values (e.g. 0.18).

Global setting:
 Transfer can be 1 for transferring elements and 2 for no transfer.

You can insert the following value types into the columns:

<str> =string

<int> =integer

<re> =real

< > =no entry. Any table cell can be empty. If a cell in the input section is empty, it matches

any property of a MEDUSA element. If a cell in the output section is empty, it is filled
during the scan, or, if scanning is finished, the default value is inserted.

The following variables can be set in the MEDUSA section:

@FRE creates a Free Line Style which is characterized in that way that it has no name. This
keyword can be set for TextStyle only.

The following variables can be set in the AutoCAD section:

@SRC states that the input value is used also in the output. If there is no equivalent value in
AutoCAD, the closest value is used.

@DEF defines that the output uses the default value. The result of scanning is not taken into
account.

@NUM can be set for Colour only. @NUM defines that the output uses the same color number
as the input. This can lead to a different color in AutoCAD and MEDUSA depending on
the definitions inside the color map.

@NAM can be set for Layer only. @NAM instructs the converter to use the MEDUSA layer label
as AutoCAD layer name. If no label is defined, the naming convention is
Layer_<layer no>.

Columns are separated by colons.You can comment out a column with two dashes (--).

A mapping table should be structured in that way, that on top of the table the special text types
are defined and in the bottom the common definitions are given. This is because scanning the
table is done from top to bottom. For details on the mapping procedure see “Mapping
Procedure” on page 24.
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Example

The table below gives the mapping table used for this example:

-- MEDUSA > AutoCAD

-- TextStyle : Layer: Color: TextType: Font: Bold: TextStyle: Font : Layer : Color: Bold: Transfer :
------------- R R R SR R R R R R S S

: : Tm : 1 : : :MEDTEXT: : @NUM : @SRC: 1

2 : : : : : :MEDTEXT:titlebox: 3 o1

11 : : L : : :MEDTEXT:hints : : o1

TCL : : :MEDTEXT:partlist: 4 o1

TR1 : 0 : : :MEDTEXT:company : 5 1

The following table gives some MEDUSA input elements on the left and the resulting AutoCAD
elements after conversion on the right. For the DXF output the closest possible DXF value is
calculated from the MEDUSA input value, given as best match (BM) in the table below. For Font
the default is usually the parameter MEDTEXT (see “Settings” on page 12).

MEDUSA AutoCAD

TextStyle Layer | Color | TextType | Font | Bold TextStyle Font Layer Color | Bold
plain_large 11 2 T1 1 0.7 plain_large MEDTEXT hints 2 0.7
plain_medium 2 3 T1 0 0.35 | plain_medium MEDTEXT | titlebox | 3 BM
plain_thin 100 4 T1 1 0.18 | plain_thin MEDTEXT | 100 4 0.18
partl 11 2 TC1 1 0.18 | partl MEDTEXT partlist | 4 BM
part2 2 2 TC1 1 0.18 | part2 MEDTEXT | titlebox | 3 BM
part3 110 2 TC1 1 0.18 | part3 MEDTEXT partlist | 4 BM
decorl 11 5 TR1 0 0.18 | decorl MEDTEXT company 5 BM
decor2 2 6 TR1 1 0.18 | decor2 MEDTEXT | titlebox | 3 BM
decor3 110 7 TR1 0 0.18 | decor3 MEDTEXT company 5 BM
decor4 11 8 TR1 1 0.18 decor4 MEDTEXT 11 BM BM

Note that in the last row of the table the MEDUSA input element does not match any line inside
the mapping table and therefore the AutoCAD- TextStyle is used as MEDUSA style name.

Mapping for Decor Text

MEDUSA AutoCAD
TextStyle Layer Color TextType Font Bold TextStyle Font Layer Color
T1 2 DT1_2 ARIBLK.TTF (*) Decor

(*) For the assigned DXF font the filename has to be used. This can be found under the
following path:
C:\windows\fonts

You can only use Windows true type fonts (*. TTF) or AutoCAD fonts (*.SHX), no Windows
bitmap fonts (*.FON)!
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Special Text

For special texttypes such as underlined text and text in a box, the online parameter MEDTEXT
(see “Settings” on page 12) is also significant. Most of these texttypes can be displayed in DXF/
DWG by special characters. When the parameter MEDTEXT is set to medtext, this conversion
Is processed automatically, otherwise only underlined text is converted.

For a correct presentation in AutoCAD, the text shape file medtext.shx located in the
subdirectory font has to be copied to the AutoCAD installation. A complete data exchange
should always include this text shape file.

If the parameter SPECTEXT_AS_PIC is set to ON inside the file cadconvert.cfg (see “Settings” on
page 12), special texts are transferred as blocks. A block contains text and lines respectively
circles.

Layer Status Mapping

In AutoCAD layers can have the states frozen, off or locked. To set these states in AutoCAD by
the translation from MEDUSA, there exists a mapping file med2dxf_layerstatus.map. In this file
you can make the settings. The path to the mapping file has to be set in the configuration file
cadconvert.cfg (see “Settings” on page 12°).

Example Table:

-- Layerstatus Mapping MEDUSA -> AutoCAD -—

CSGCONVTYPE - CSGMED42DXF

CSGMAPPINGTYPE : CSGLAYERSTATUSMAPPING

-- DXF-Layer : Status FROZEN / HIDDEN / LOCKED

_______________ o
11 - FROZEN

» Status FROZEN: The layer has the state frozen in AutoCAD.
» Status HIDDEN: The layer has the state off in AutoCAD.
» Status LOCKED: The layer has the state locked in AutoCAD.

Combinations of the states are possible.
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Default Mapping - Graphical User Interface

The files which define the mapping between MEDUSA and AutoCAD are available as text files,
which can be edited inside the graphical user interface of MEDUSA.

This section gives you the dialogs. Below each dialog you will find a link to the section which
gives detailed explanations on the entries of the appropriate mapping table.

Open the Mapping Tables Dialog

Please note: The Interfaces -> DXF/DWG Mapping Tables function is only available in the Admin mode.

Choose the entry Options from the main menu and then Interfaces -> DXF/DWG Mapping Tables.

Figure 4 Open Mapping Tables

Options | Utilities Bacis1 “Windows Licenses Help
Defaults ... ® O & ||EE|

| Interfaces ’ OxF /DG
Admin Mode DXF/DWWG Mapping Tables
Configuration DXF/DVYG Config Path

The dialog CADConvert Mapping Tables opens. The first tab you see is DXF -> MED Line (see “Mapping
Lines, DXF to MEDUSA” on page 41).

Buttons of the Mapping Tables Dialog

Figure 5 Dialog Mapping Tables, Buttons

Save Cancell Reaetl

Save
stores the settings into the corresponding mapping files. In the next session of
MEDUSA these settings are used.

Cancel
closes the dialog without applying the parameters of the mapping tables.

Reset

restores the current data to the last saved data in the corresponding mapping file.
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Mapping Lines, DXF to MEDUSA

CADConvert Mapping Tables
DXF-=MED Text | MED-=DXF Line | MED-=D¥F Text | MED->MED Text |

File <instalipath='cadconvert/cfy/dxf2Zmed |style. map

DxF-Linestyle | OxF-Layer | DxF-Color | DF-Bald | MED-Linestyle | MED-Layer | MED-Calor | MED-Lit
1 | hidden_line hidden_line ichdef ichdef icdef
2 |centre centre icdef ichdef icdef
3 |chain_thin chain_thin ichdef ichdef icdef
4 |chain_medium chain_medium | @def ichdef icdef
g |chain_thick chain_thick ichdef ichdef icdef
E |construction construction ichdef ichdef icdef
BEISE|EI'_-,-'Ef
For details on the parameters see “Default Mapping DXFMed/DWGMed”, “Line Style Mapping”
on page 22.

Mapping Texts, DXF to MEDUSA

MED->DXF Line | MED->DXF Text | MED->MED Text |

File =instalipath=/cadconvert/cfy/dxf2Zmed tstyle.map

DxF-Style| DXF-Faont | DxF-Laye| DxF-Colar| DxF-Bald | MED-Style | MED-Layer | MED-Caolar | MED-Typeg ME
1 7 Esre
BEISE|EI'_-,-'Ef

Cancell Reaetl

Save

For details on the parameters see “Default Mapping DXFMed/DWGMed”, “Text Style Mapping”
on page 26.
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Mapping Special Texts, DXF to MEDUSA

DXF->MED Line | DXF->MED Text | MED->DXF Line | MED->DXF Text | MED->MED Text:

File <installpath=/cadconverticfg/med2med_tstyle. map

Texttype Lnderlined Ciwerlined Boxed Circle Sausage

1 |01 012 O OT3 DOTa OT4
2 | M LM T TR1 TC1 T51
3 | T2 TLIZ T2 TR2 TCZ 152
4 | T3 T3 T3 TR3 TC3 T53
5 |=T1 LM T TR1 TC1 T51
B |=T2 TLIZ T2 TR2 TCZ 152
Save Cancell Reaetl

For details on the parameters see “Default Mapping DXFMed/DWGMed”, “Text Style Mapping”,
“Special Text” on page 29.

Mapping Lines, MEDUSA to DXF

D¥F->MED Line | DXF->MED Text MED-=D%F Text | MED->MED Text |
File <instalipath=/cadconvert/cfy/med2dxf |style. map

MED-Linestylel MED-Layer | MED-Calar | MED-Linetype | MED-Bold DxF-Linestyle | DF-Layel DxF-Caolar | C
1 |LTXT LT=T Esre i
2 |LPEM 82 LPRM Esrc i
3 |LPEM LPRM Esrc i
4 |LSUP LSUF Esrc i
g |LFLIN LFUM Esrc i
& |hidden_line hidden_line iEsre iEsre C

BEISE|EI'_-,-'Ef

For details on the parameters see “Default Mapping MedDXF/MedDWG”, “Line Style Mapping”
on page 32.
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Mapping Text, MEDUSA to DXF

MED-=MED Text |

File <instalipath=/cadconvert/cfg/med2dxf tstyle map

MED-Style | MED-Layd MED-Caolol MED-Type | MED-Fant MED-Bold DxF-Style | DxF-Font | DXF-Layel| C

1 TLL

2 |boxed TR1 boxed TEXT

3 |circle T circle TEXT

4 |default T default TEXT

5 |shest_title TTI sheet_title TEXT

B |drawing_nurr T=H drawing_nur TEXT
BEISE|EI'_-,-'Ef

For details on the parameters see “Default Mapping MedDXF/MedDWG”, “Text Mapping” on
page 36.
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The presentation of broken line styles is fundamental different in MEDUSA and AutoCAD. In
AutoCAD it depends from the zoom factor and resolution but not in MEDUSA.

To make the presentation of these lines in AutoCAD equal to MEDUSA, the user has the
possibility to make an entry in the file cadconvert/cfg/medstyle.cfg. Open the file in an editor and
insert a new style description as given in the example below.

Example:

[-——————- [-————- [-——————- [-———- line, space, line, space,
| - style number according to line type
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Changing the Configuration via User Interface

It is possible to change the configuration of CADConvert via MEDUSA User Interface. For this,
you need a specific directory structure.

Directory Structure

It is searched for all subdirectories of all cc_custom folders in all directories in the product list.
This folders must contain a cadconvert.cfg file. It is used for the configuration and mapping of
CADConvert.

Figure 6 Directory Structure
product
cc_custom
A B C
cadconvert.cfg cadconvert.cfg cadconvert.cfg
mapping tables mapping tables mapping tables

Creating Directory Structure

1. Create a folder named cc_custom within a product.

2. Create subdirectories within the cc_custom directory as many as desired
(example: A, B, C).

3. Copy the cadconvert.cfg file and the mapping files from the cfg directory of the english
original product (<medusa>\cadconvert\cfg) into your subdirectory (e.g. cc_custom\A).

4. Change the mapping tables as required and modify the cadconvert.cfg file by giving the
path to the modified mapping files
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Figure 7 Example of the modified path in the cadconvert.cfg file

B cadconvert.cfg - Editor
Datei  Bearbeiten  Format  Ansicht 7

-- CADConvert Main Configuration File

-- IMPORTAMNT :
-- Path delimiter character MUST be a slash "/" to make sure
-- that this file can be used at all platforms (PC, UNIX).

-- General CADCONVERT Settings
HELFFATH = ${CADCONVERT }/heln/ab

-- Linestyle Mapping
MEDD=F_LTIMESTYLE_MAP
DxFMED_LTIMESTYLE_MAP

D:/user_product/cc_custom/B/med2dxt_Istyle.map
D:/user_product/cc_custom/B/dxf2med_Tstyle.map

-- Textstyle Mapping|

N R B T i [P = RPN [ TN PUPRF PSR R,

User Interface

In order to switch between different configurations:
1. Choose Options > Interfaces > DXF/DWG Config Path.

Figure 8 The DXF/DWG Config Path Option

Options | Utilities Bacis1 “Windows Licenses Help
Defaults ... @ ®6 o ”ﬂ |||

| Interfaces ’ OxF /DG
Admin Mode DXF/DWWG Mapping Tables
Configuration DXF/DVYG Config Path

The CADConvert Configuration Path dialog is displayed.

Abb. 9 Configuration Path Dialog
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By default the input field of the dialog displays the path to the cadconvert.cfg file of the
MEDUSA installation directory, respectively, if the environment variable
CADCONVERT_CUSTOM is set, it is the path to the directory defined by that variable
which is displayed.
Using the arrow, you can display a list of all existing folders of your products, which are
located within the cc_custom directory and contain a cadconvert.cfg file.
2. Choose the path to the desired cadconvert.cfg file, by selecting the accordant directory.
3. Click on Apply to use the file for the conversion. A click on ok additionally closes the
dialog.

Now, when you open the Options DXF/DWG Interface dialog via Options > Interface >DXF/DWG, the path
to the desired cadconvert.cfg file is displayed on both index cards.

Figure 10 Options Dialog with Path to the used cfg File

— o] %]
Keyward “alue
BLOCKMNAME ] On
=L IkAD S |y B
LIEE THUELLLUH (AT
¥REF L] On

D:wser productice customiBhcadconvert. cfy

DKl Cancell Reaetl Helpl

When you open the mapping tables via Options > Interfaces > DXF/DWG Mapping Tables, the path
defined in the chosen cadconvert.cfg file is displayed at the top of the tabs.

Figure 11 Example of a Mapping Table with Path to a User defined cadconvert.cfg File

t Mapping Tables
DXF-=MED Text | MED-=DXF Line | MED-=D¥F Text | MED->MED Text |

File D:fuser producticc custom/Bidxt2med |style.map

OxF-Linestyle | OxF-Layer | DxF-Color | DRF-Baold | MED-Linestyle | MED-Layer | MED
1 | hidden_line hidden_line ichdef Ed
2 |centre centre ichdef Ed
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LIST OF COMMANDS

This chapter lists all commands available for DXFMed / DWGMed and MedDXF / MedDWG.

¢ COMMON COMMEANAS . vttt et enns 50
o DXFMEd / DWGIME ..o 60
o MedDXF /I MEUADWG .....oeii e 73
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Common Commands

The following list contains the common commands valid for both conversion types:

CD Changes the working directory

CODE Specifies a pathname for a MEDUSA CODE file.

DDL Specifies a pathname for a MEDUSA DDL file.

DIR Lists the contents of a directory.

ERRFILE Specifies a pathname for the error file.

ERRLOG Controls whether a ERRLOG-file is written.

GO Starts the translation.

HELP Displays information on the specified command.

HELPPATH Specifies a path to the help files.

IN Specifies the pathname of the input file.

LINESTYLE Specifies the pathname of the linestyle mapping file.

LIST Specifies the pathname of the listing file.

LS Lists the content of an directory.

MAPFILE Specifies the pathname for the mapfile.

MAPLOG Controls whether a MAPLOG-file is written.

MEDCODE Specifies the MEDUSA Code number for the conversion.

MESSPATH Specifies the pathname of the message file.

OVERWRITE Controls whether or not an already existing output-file with the same name
should be over written.

PRIM Specifies the pathname for a MEDUSA PRIM-file.

QUIT Quits the program.

RESET Resets the conversion adjustments to standard or to the definitions of a config-
uration file.

SAVE Writes the current settings into the cadconvert.cfg file.

SHOW Shows the conversion adjustments.

TEXTSTYLE Specifies the pathname for the textstyle-mapping-table.

USETRUECOLOR | Controls whether True Colors will be fransfered.

! is used to enter commands of the operating system under CADConvert.
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CD
SYNTAX cd [Pathname]
DESCRIPTION This command will change the working directory.
If Pathname is a backslash (Windows) or slash (Unix) you change
into the root directory.
OPTIONS Pathname
Full pathname of the directory you want to change to.
EXAMPLE cd /
cd /proj
CODE
SYNTAX code [pathname]
DESCRIPTION The command code specifies the pathname for the MEDUSA
CODE file.
OPTIONS pathname
Full pathname of the MEDUSA CODE file.
EXAMPLE DXFMED> code /medusa/projl3b/m2d/bin/code.bin
DDL
SYNTAX ddl [pathname]
DESCRIPTION The command dd 1 specifies the pathname for the MEDUSA DDL-
file to be use during translation.
OPTIONS pathname
Full pathname of the desired MEDUSA DDL-file.
EXAMPLE MEDDXF> ddl /medusa/projl3a/m2d/bin/ddl._bin
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DIR
SYNTAX dir
dir [Pathname]
DESCRIPTION This command lists the content of the working directory, or the con-
tent of the directory pointed to by pathname.
OPTIONS Pathname
Full pathname of the directory, which content will be listed
EXAMPLE dir
dir ddl /medusa/Zprojl3a/m2d/bin
ERRFILE
SYNTAX errfile [pathname]
DESCRIPTION If errlog is on, the systems creates an error message file contain-
ing any error messages generated during translation.
If errors occur, the program informs you about messages in the error
file. If there are no errors, you will not receive an error message.
The error file is an ASCII file you can read using a text editor.
OPTIONS pathname
Full pathname for the error message file to be used.
EXAMPLE errfile /medusa/medtemp/errors.err
ERRLOG
SYNTAX errlog [on/off]
DESCRIPTION on
ERRLOG-file will be written.
off
ERRLOG-file will not be written. Errors are written directly into the
console (DOS box).
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GO
SYNTAX go
DESCRIPTION The command go starts the translation.
EXAMPLE MEDDXF> go
HELP
SYNTAX help [command]
DESCRIPTION The command he Il p without a parameter shows a list of all available
commands or on the specified command.
OPTIONS (no option)
Displays a list of all available commands.
command
Displays information about the selected command.
EXAMPLE MEDDXF> help in
HELPPATH
SYNTAX helppath [pathname]
DESCRIPTION The command he l ppath specifies a path to the help-files. Help files
have the suffix .hlp.
OPTIONS pathname
Full pathname of the help files.
EXAMPLE DXFMED> helppath /medusa/cadconvert/help/ger
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IN

SYNTAX in [pathname]

DESCRIPTION The command in specifies the pathname of the input file you want
to translate into the output file format.

OPTIONS pathname
Full pathname of the input file to be converted. The length of the
pathname is limited to 256 signs.

EXAMPLE DXFMED> in /data/dxf/D008.dxf
MEDDXF> in /data/sheets/9876543.she

LINESTYLE

SYNTAX linestyle [pathname]

DESCRIPTION The command I inestyle specifies the pathname of the linestyle-
mapping-table for the translation.

OPTIONS pathname
Full pathname of the linestyle-mapping-table.

EXAMPLE DXFMED> linestyle /custom/cfg/dxf2med_Istyle._map

LIST

SYNTAX list [pathname]

DESCRIPTION The command list indicates the pathname of the list-file containing
the files you need to convert. After list you have to start the process
with go.

OPTIONS pathname
Full pathname of the list-file to be processed. The length of the path-
name is limited to 256 signs.

EXAMPLE DXFMED> list /data/dxf/allfiles.list
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LS
SYNTAX Is
Is [pathname]
DESCIPTION This command lists the content of the working directory, or the con-
tent of the directory pointed to by pathname.
OPTIONS pathname
Full pathname of the directory, which content will be listed
EXAMPLE Is
Is ddl /medusa/projl3as/m2d/bin
MAPFILE
SYNTAX mapfile [pathname]
DESCRIPTION The command mapTi e specifies the pathname for the mapfile. If
Maplog is on, the Made-Mapping will be written into this file.
'Made Mappings’ means, that CADConvert analyses the layer, color
and text types of the drawing which has been loaded and makes a
default mapping that depends of the output system.
To make your own mapping, you have to open the mapfile in an edi-
tor. You can change the mapping and than save the file. To use your
own mapping, start CADConvert again.
OPTIONS pathname
Complete pathname of the mapfile.
EXAMPLE DXFMED> mapfile /project/maplogs/defaults.map
MAPLOG
SYNTAX maplog [ on / off / append ]
DESCRIPTION on
Writes a MAPLOG-file.
off
No MAPLOG-file will be written.
append

existing MAPLOG-file will be extended.
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MEDCODE
SYNTAX medcode [ codenummer 7]
DESCRIPTION The command medcode sets the MEDUSA codenumber for the con-
version.
OPTIONS 1-10
The Default is code 1
EXAMPLE medcode 5
MESSPATH
SYNTAX messpath [pathname]
DESCRIPTION The command messpath specifies the pathname of the message
files.
OPTIONS pathname
Full pathname of the DXFMED message files.
EXAMPLE DXFMED> messpath /medusa/cadconvert/mess/gb
OVERWRITE
SYNTAX overwrite [ on / off ]
DESCRIPTION With overwrite set to on, existing files with the same name as the
current output filename are over written without warning.
overwr ite default is ON.
OPTIONS on
If a file by the same name exists, it is over written without warning.
off
A warning is displayed prior to over writing any existing files.
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EXAMPLE

In the following example overwrite is set to ofF. The output-file
exists.

conversion of drawings

MEDDXF> in DOOS8

MEDDXF> out D008-940314.dxf
MEDDXF> go

File exists, overwrite? (Y /7 N)
MEDDXF

conversion of lists

this question is asked:
File exists, overwrite?

PRIM
SYNTAX prim [pathname]
DESCRIPTION The command prim specifies the pathname of a MEDUSA PRIMS
file for the translation.
OPTIONS pathname
Full pathname of the PRIM file.
EXAMPLE DXFMED> prim /medusa/Zprojl3b/bin/prims.bin
QUIT
SYNTAX quit
DESCRIPTION Use quit to exit from the utility.

If you are running the utility from within MEDUTIL, for example, you
will return to the MEDUTIL prompt.

© CAD Schroer GmbH
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RESET
SYNTAX reset

reset [Filenam ]

DESCRIPTION The command reset without filename resets the conversion rele-
vant settings to the values of the default file cadconvert.cfg. This file
is in the product path below the directory cfg.

This command with filename sets the settings to the values of the
named file.

EXAMPLE DXFMED> reset projects/userproj/cadconvert_usr.cfg

SAVE
SYNTAX save [Tilename]
DESCRIPTION Saves the current settings of CADConvert in a named file.
EXAMPLE save cadconvert_usr.cfg
SHOW

SYNTAX show

DESCRIPTION The command show displays relevant settings of the program.
TEXTSTYLE

SYNTAX textstyle [pathname]

DESCRIPTION The command textstyle specifies the pathname for the textstyle
mapping table.

OPTIONS pathname
Full pathname for the textstyle mapping table.

EXAMPLE DXFMED> textstyle /custom/cfg/dxf2med_tstyle.map

MEDDXF> textstyle /custom/cfg/med2dxf_tstyle.map
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USETRUECOLOR

SYNTAX usetruecolor [ on / off ]

DESCRIPTION With usetruecolor set to on, True Color RGB values will be trans-

ferred, if defined.

usetruecolor default is off.

Note that True Color RGB values can be defined in AutoCAD since
version 2004.

SYNTAX I [command]

DESCRIPTION To enter a command of the operating system under CADConvert,
you have to write ! in front of the command.

OPTIONS command
command of the operating system

EXAMPLE I chmod ...

© CAD Schroer GmbH 59



MEDUSA, CADConvert

List of Commands

CAD Schroer

DXFMed / DWGMed

Commands for the conversion from DXF/DWG to MEDUSA:

BLOCKNAME Controls whether the name of the individual block should be appended to
the corresponding clump (group).

CLUMPS Controls whether the entire block depth should be undertaken during the
translation.

CONVSPACE Defines how paper / model spaces from AutoCAD are translated

DXFIN_CHARSET

Specifies the code of the text transfer, if no CODEPAGE is set within the
DXF/DWG file.

DXFMED_DIMENSION

Specifies the handling of dimensions during the translation.

FORCE_DXFIN_CS

Controls whether the dxfin_charset entry shall be used as code defi-
nition with the text transfer, even if a CODEPAGE definition exists within
the DXF/DWG file.

FILLGAP

Influences the distance of the cross-hatching for special imported ele-
ments

HIDDENLAYER

Handles the translation of layers with status off or frozen.

LIMIT_MAXSIZE

Limit the maximum size to four times of the size of the sheet.

LINEWEIGHT_DEFAULT

Defines the line weight for default lines.

MEDDIM_STANDARD

Controls the way of creating dimensions.

MEDPRECISION

Specifies the precision of the MEDUSA-drawing.

MOVE Controls whether the variable EXTMIN should be used as (0,0).
ouT Specifies the pathname of the MEDUSA output-file.

PAPSPACE Defines the paper space of the DXF/DWG

PROJECT Specifies the pathname for a MEDUSA PROJECT-file.

PROXY Controls whether Proxy-elements, which contain graphical elements,

should be transferred to MEDUSA and should be associated to a clump.

READ_PAPSPACE

Lists all paper spaces of a DXF/DWG input file.

SCALE

Specifies a scale multiplier.

SHEETSIZE

The size of the sheet is either determined by entries of the DW/DWG file
or of the geometry size.

SPATIALFILTER

Specifies to display only a certain area of a block cut in AutoCAD or the
complete block.

SPECTSTYLE

Specifies the pathname for the spectstyle-mapping-table.

SPLINEAPPROX

Controls the way of approximation of splines in MEDUSA
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SUBCLUMP_TYPE

Defines the group type used for a nested structure

UNITS

Sets the sheet-units to mm or inch.

XREF

Controls whether external refences are processed during conversion or
not.

The following list contains the common commands valid for both conversion types:

CD Changes the working directory

CODE Specifies a pathname for a MEDUSA CODE file.

DDL Specifies a pathname for a MEDUSA DDL file.

DIR Lists the contents of a directory.

ERRFILE Specifies a pathname for the error file.

ERRLOG Controls whether a ERRLOG-file is written.

GO Starts the translation.

HELP Displays information on the specified command.

HELPPATH Specifies a path to the help files.

IN Specifies the pathname of the input file.

LINESTYLE Specifies the pathname of the linestyle mapping file.

LIST Specifies the pathname of the listing file.

LS Lists the content of an directory.

MAPFILE Specifies the pathname for the mapfile.

MAPLOG Controls whether a MAPLOG-file is written.

MEDCODE Specifies the MEDUSA Code number for the conversion.

MESSPATH Specifies the pathname of the message file.

OVERWRITE Controls whether or not an already existing output-file with the same name
should be over written.

PRIM Specifies the pathname for a MEDUSA PRIM-file.

QUIT Quits the program.

RESET Resets the conversion adjustments to standard or to the definitions of a config-
uration file.

SAVE Writes the current settings into the cadconvert.cfg file.

SHOW Shows the conversion adjustments.

TEXTSTYLE Specifies the pathname for the textstyle-mapping-table.

USETRUECOLOR Controls whether True Colors will be fransfered.

is used to enter commands of the operating system under CADConvert.
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BLOCKNAME
SYNTAX blockname [ on /7 off ]
DESCRIPTION With the command blockname, you can decide if the individual
block should be appended to the corresponding clump.
OPTIONS on

The clumps made during the translation are appended to the names
of the corresponding blocks as an attribute.

off

The clumps made during the translation are not appended the
names of the corresponding blocks as an attribute.

CLUMPS
SYNTAX clumps [ on 7/ off ]
DESCRIPTION With AutoCAD you can organize the clumps very accurate.

The command clumps sets how the entire block depth should be
used the translation.

OPTIONS on

The entire depth of block structure is used for translation to
MEDUSA file format.

off

The block structure is lost completely.
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CONVSPACE
SYNTAX convspace [ paper / all_paper / model ]
DESCRIPTION Different paper and model spaces of AutoCAD can be written to single
MEDUSA files.
With this function you can switch between the different types of translation.
OPTIONS paper

MEDUSA checks whether several paper spaces are available. If more than one
layout is found, a dialog appears which lists all paper spaces and you can
choose the required one.
In MEDUTIL the available paper spaces are listed by the read_papspace
command. The required one can be defined using the
papspace [number]command (see page 69).
If only one paper space exists, it is directly transferred from AUTOCAD to
MEDUSA.
If the switch is set to convspace paper only DXF/DWG files with a paper
space are imported.
If no paper space exists, no MEDUSA drawing is created!
convspace paper is available in the MEDUSA Ul, in MEDUTIL and offline,
but not with the list conversion.
all_paper
All paper spaces of a DXF/DWG file are converted into MEDUSA at once. Dur-
ing the process single MEDUSA files are created from each paper space of the
DXF/DWG file as part of a working set (.wsd file). Then, all files belonging to
that working set can be opened at once.
The files are automatically stored in the directory of the DXF/DWG file using the
following naming convention:
IN:  <path>/<DXF filename=>.dxf
OUT: <path>/<DXF- filename>_<layout name>.she

<path>/<DXF filename>.wsd
It is also possible to define another path and filename. The naming of the .wsd
file is created accordingly.
Example:
OUT: E:\abc

E:\abc.wsd
convspace all_paper is only available at MEDUTIL command line
prompt, not in the UI.
model
Only the model space of AutoCAD will be converted to a MEDUSA sheet.
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DXFIN_CHARSET

SYNTAX dxfin_charset [ Code ]

DESCRIPTION Usually a DXF/DWG file contains a text code entry.

By default the entry within the DXF/DWG file is DXFIN_CHARSET ANSI_1252.
Via dxFin_charset you can specify different codes.

If CODEPAGE is not set within the DXF/DWG file, the dxfin_charset-entry is
used.

EXAMPLE ANS1_932 (Code of Japanese Shift-JIS)

Please note: The following codes are possible:

ANSI 932 - japanese Microsoft Shift-JIS
ANSI 936 - GBK simplified chinese
ANSI 950 - BIGS traditional chinese
ANSI 1250 - east european latin

ANSI 1251 - cyrillic

ANSI 1252 - west european latin

ANSI 1253 - greek

ANSI 1255 - hebrew

EUC-JP - UNIX japanese encoding
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DXFMED_DIMENSION

SYNTAX dxfmed_dimension [ geo /7 dim / com ]

DESCRIPTION Using the command dimension, you can convert the dimension geo-
metrically (geo), as genuine dimensioning (dim) or in a combined
manner (com).

With the geometrical conversion (geo), the geometrical copy of
dimensioning is received. However, all functionality is lost.

With a genuine dimensioning conversion (dim), functionality sur-
vives. However, because AutoCAD and MEDUSA take different
approaches to dimensioning, there may be some differences.

With the combined conversion (com), the genuine dimensioning is
also maintained, however, a geometrical copy is first deposited.
Case differences exist between the converted dimensioning and the
geometrical representation of the original dimensioning. These
become visible at the next UNDIM / REDIM.

OPTIONS geo

During the conversion, dimensioning as a geometrical copy is cre-
ated according to MEDUSA. The functionality is lost.

dim

The conversion translates the genuine dimensioning according to
MEDUSA and functionality is kept.

com

The conversion transmits the genuine dimensioning, however, it first
creates a geometrical copy. The functionality is preserved. Differ-
ences occur only after the first UNDIM / REDIM.

FORCE_DXFIN_CS

SYNTAX force_dxfin_cs [ on/off ]

DESCRIPTION The switch is directly associated with the dxfin_charset entry
(see above).

It controls whether the dxFin_charset entry is used, even if a
CODEPAGE is given within the DXF/DWG file.

OPTIONS on

In any case the dxfin_charset entry is used, even if a CODEPAGE
entry exists within the DXF/DWG file.

off

The code entry of the DXF/DWG file is used.

ofT is default setting.
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FILLGAP

SYNTAX fillgap [ value ]

DESCRIPTION AutoCad creates (for example) arrows with an element, which is

unknown in MEDUSA.

This element will be imitated by creating a contour which will be
cross hatched. If the drawing is very large, the range of the hatching
may become very small, this causes a big number of line-elements.
By using i llgap the range can be controlled and there are less
elements in MEDUSA

OPTIONS value
Value of range of cross hatching.
EXAMPLE DXFMED> fillgap 0.002

HIDDENLAYER

SYNTAX hiddenlayer [ on / off ]

DESCRIPTION This switch defines wether layers with the status frozen or off are
translated to MEDUSA or not.
If the switch is not set, on is default.

OPTIONS on

Layers with the status frozen or off are translated
off

Layers with the status frozen or off are not translated

LIMIT_MAXSIZE

SYNTAX limit_maxsize [ on /7 off ]

DESCRIPTION Very large arcs can be the reason for a very large maximum size of a
MEDUSA sheet. This might cause problems for MEDUSA to handle
the sheet. With this command you can limit the maximum size to four
times of the size of the sheet.

If limitation is on it can happen that some warnings are given when
loading the sheet into MEDUSA.

EXAMPLE limit _maxsize on

66 © CAD Schroer GmbH



A— MEDUSA, CADConvert
@ \D) DXFMed / DWGMed

CAD Schroer

LINEWEIGHT_DEFAULT

SYNTAX lineweight_default [ value ]

DESCRIPTION In AutoCAD there is the possibility to control the line weight not only
directly but also by defining a default value. The value for the default
is defined in the AutoCAD installation file and is not part of the DXF
format. With 1ineweight_default you can assign a value to the
default line weight as it will be used in MEDUSA.

Default value is 0.0.

EXAMPLE lineweight _default 0.5

MEDDIM_STANDARD

SYNTAX meddim_standard = [ on /7 off ]

DESCRIPTION The command meddim_standard controls the way of dimension

creation from AutoCAD to MEDUSA.

Please note: This switch can be set in the configuration file cadcon-
vert.cfg only.

OPTIONS on

Standard MEDUSA dimensions with default thicknesses and colors
will be created. Also the size of the arrows will conform with the stan-
dard. This is the default setting.

off

Thickness, color and size of arrows will be determined by the given
AutoCAD values and the mapping facility.

MEDPRECISION

SYNTAX medprecision [ low / medium / high ]

DESCRIPTION The command medprecision specifies the amount of precision for
the MEDUSA-drawing.

OPTIONS low
MEDUSA-sheet with low precision is generated (6 digits).
med 1um
MEDUSA-sheet with medium precision is generated (9 digits).
high
MEDUSA-sheet with high precision is generated (12 digits)

© CAD Schroer GmbH 67



MEDUSA, CADConvert

List of Commands ercpé\hm
MOVE
SYNTAX move [ on / off ]
DESCRIPTION With the command move you set the variable EXTMIN be used or
not be used as (0,0).
OPTIONS on
EXTMIN will be used as ( 0,0).
off
EXTMIN will not be used as (0,0).
ouT
SYNTAX out [ pathname ]
DESCRIPTION The command out specifies the pathname for the output MEDUSA
sheet.
If you do not specify an output pathname, the output sheet is created
in the current directory.
OPTIONS pathname
Full pathname of the output sheet file. The length of the pathname
must not exceed 256 characters.
EXAMPLE DXFMED> out /data/sheets/9876543.she
PROJECT
SYNTAX project [ pathname ]
DESCRIPTION Specifies the pathname of a MEDUSA project. This must be a valid
MEDUSA project.
OPTIONS pathname
Full pathname of the project file.
EXAMPLE DXFMED> project /projects/proj_jebl4
68 © CAD Schroer GmbH




MEDUSA, CADConvert

) DXFMed / DWGMed
PROXY
SYNTAX proxy [ block / entity / off ]
DESCRIPTION Controls whether Proxy-elements, which contain graphical elements,
should be transferred to MEDUSA and should be combined to a
clump.
OPTIONS block
is the default setting. Proxy-elements are combined to clumps
entity

Graphical elements are transferred as simple elements
off

Proxy-elements are ignored, i.e., they are not transferred to
MEDUSA.

READ_PAPSPACE / PAPSPACE

SYNTAX

read_papspace/papspace [number]

DESCRIPTION

The command relates to the convspace command (see page 63).
read_papspace causes the listing of all available paper spaces of
the DXF/DWG input file.

The following papspace [nummer]command defines the paper
space, which shall be converted into MEDUSA.

SCALE

SYNTAX

scale [ factor / auto ]

DESCRIPTION

The MEDUSA scale factor is different from the AutoCAD scale fac-
tor.

The command scal e indicates which scale factor is written into the
MEDUSA file during the conversion.

OPTIONS

factor

Value for the sheet scale (> 0.0).

auto

The DXF-File usually contains a value for DIMSCALE. If it does con-
tain a value, it is taken for the sheet scale, if not 1.0 is set.
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SHEETSIZE

SYNTAX sheetsize [ byDXFfile / byGeometry ]

DESCRIPTION The size of a MEDUSA sheet may either be determined by a size

entry in the DXW/DWG file (extmin, extmax), or it is calculated
according to min., max. of the geometry.

Reading the value out of the file can resolve problems, because not
every system writes this entry correctly.

OPTIONS byDXFfile

Sheet size is selected out of the DXF/DWG file.
byGeometry

Sheet size is calculated from geometry.

SPATIALFILTER

SYNTAX spatialfilter [on / off]

DESCRIPTION The command spatial filter specifies to display only a certain
area of a block cut in AutoCAD or the complete block.

OPTIONS on

Only the part of the cut block which is visible in AutoCAD will be dis-
played in MEDUSA.

off

The complete block will be displayed in MEDUSA.

off is default setting.

EXAMPLE DXFMED> spatialfilter ON
SPECTSTYLE

SYNTAX spectstyle [ pathname ]

DESCRIPTION The command spectstyle specifies the pathname of the spect-
style mapping table.

OPTIONS pathname
Full pathname of the spectstyle mapping table.

EXAMPLE DXFMED> spectstyle /custom/cfg/med2med_tstyle._map
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SPLINEAPPROX

SYNTAX splineapprox [linear / conic]
DESCRIPTION Controls the way how splines are approximated at curves.
OPTIONS linear
Approximation of curves is carried out by line segments.
conic
Approximation of curves is carried out by conic arcs.

SUBCLUMP_TYPE

SYNTAX subclump_type [ type ]

DESCRIPTION Usually CADCONVERT creates a nested group structure using the

element type named group (with the old type SET it would look like

this: SET > SET > SET...). In some cases it might be useful to define
a different sub-group, in order to create structures like SET > UCL >
SET > UCL..., for example.

OPTIONS type
Valid group type, e.g. UCL.

UNITS

SYNTAX units [ mm / inch ]

DESCRIPTION MEDUSA works unlike AutoCAD with units. The command sets the
sheet-units to mm or inch.

OPTIONS mm
The unit mm will be used during translation.
inch
The unit inch will be used during translation.
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XREF

SYNTAX xref [ on / off ]

DESCRIPTION The switch controls whether external references, which are content

of a DWG sheet, are processed and transferred to MEDUSA or not.

OPTIONS on

References within the DWG file are processed during conversion
and appear as SET (Clump) in the MEDUSA sheet.

off

References within the DWG file are not processed during conver-
sion, i.e. they do not appear within the MEDUSA sheet.

off is default setting.

72 © CAD Schroer GmbH



CAD Schroer

MEDUSA, CADConvert
MedDXF / MedDWG

MedDXF / MedDWG

Commands for the conversion from MEDUSA to DXF/DWG:

ACADVERSION

Specifies the ACAD version to which you want to convert the MEDUSA
sheet.

BIGFONT Supports text fonts with more than 255 characters.

BLOCKS Controls whether or not MEDDXF should take over the complete clump-
structure.

CLUMPNAME Controls whether the group name should be taken over as block name or
not.

COLORS Controls whether or not MEDDXF should take over the attachment between
colors and pens.

CONTEXTCHECK A MEDUSA sheet is opened either considering or regardless of code and

DDL.

DXFOUT_CHARSET

Specifies the text code within the DXF/DWG file.

DXFPRECISION

Specifies the number of digits in the DXF-file.

FORCE_DXFOUT_CS

Controls whether the dxfout_charset entry shall be used as code defini-
tion with the text transfer.

LTSCALE

Defines the proportion of drawing units to line definition units for broken
lines.

MEDDXF_DIMENSION

Specifies the handling of dimensions during the translation.

MEDTEXT

Specifies the pathname of the text definition-file.

MEDTEXT_GDT

Optimizes the representation of bordered text.

PM5 Controls wether PM5 elements are transferred to ACAD or not

ouT Specifies the pathname of the DXF output-file.

POLYLINE Controls whether or not a complex, drawn by polylines, should be saved to
the DXF-file as a polyline or a complex of lines.

PROJECT Specifies the pathname for a MEDUSA PROJECT-file.

SPECTEXT_AS_PIC

Special text types are transferred as a block, including text and graphic. ele-
ments.

SUPERLINEMODE

Supports the translation of Superlines as graphic.

TEXTBOX

Optimizes the text representation in DXF/DWG.

TEXTHEIGHT_ZERO

Determines whether text with height zero is transferred or not.

UNSCALE

Sets the sheet scale and the drawing to 1:1
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The following list contains the common commands valid for both conversion types:

CD Changes the working directory

CODE Specifies a pathname for a MEDUSA CODE file.

DDL Specifies a pathname for a MEDUSA DDL file.

DIR Lists the contents of a directory.

ERRFILE Specifies a pathname for the error file.

ERRLOG Controls whether a ERRLOG-file is written.

GO Starts the translation.

HELP Displays information on the specified command.

HELPPATH Specifies a path to the help files.

IN Specifies the pathname of the input file.

LINESTYLE Specifies the pathname of the linestyle mapping file.

LIST Specifies the pathname of the listing file.

LS Lists the content of an directory.

MAPFILE Specifies the pathname for the mapfile.

MAPLOG Controls whether a MAPLOG-file is written.

MEDCODE Specifies the MEDUSA Code number for the conversion.

MESSPATH Specifies the pathname of the message file.

OVERWRITE Controls whether or not an already existing output-file with the same name
should be over written.

PRIM Specifies the pathname for a MEDUSA PRIM-file.

QUIT Quits the program.

RESET Resets the conversion adjustments to standard or to the definitions of a config-
uration file.

SAVE Writes the current settings into the cadconvert.cfg file.

SHOW Shows the conversion adjustments.

TEXTSTYLE Specifies the pathname for the textstyle-mapping-table.

USETRUECOLOR | Controls whether True Colors will be fransfered.

! is used to enter commands of the operating system under CADConvert.
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ACADVERSION

SYNTAX acadver [ version ]

DESCRIPTION This switch is used to specify the ACAD version to which you want to
convert the MEDUSA sheet.

OPTIONS version
is one of ACAD12, ACAD13, ACAD14, ACAD2000, ACAD2004,
ACAD2005, ACAD2006, ACAD2007, ACAD2008, ACAD2009,
ACAD2010.

EXAMPLE acadver acad2006

BIGFONT

SYNTAX bigfont [ filename ]

DESCRIPTION This switch is used for text fonts with more than 255 characters. (e.qg.
Japanese text)

OPTIONS filename
If the switch is set text fonts with more than 255 characters can be
used.

EXAMPLE bigfont bigfont.shx

BLOCKS

SYNTAX blocks [ on /7 off ]

DESCRIPTION In MEDUSA you can organize the clumps very complex.
The command blocks controls how the translator builds the clump-
structure.

OPTIONS on
The whole clump-structure is build.
off

The clump-structure is lost.
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CLUMPNAME
SYNTAX clumpname [ on /7 off ]
DESCRIPTION Controls whether the group name should be taken over as block
name or not. OFF is default setting.
OPTIONS on

Groupnames from MEDUSA are transferred as blocknames to DXF.
Equal groupnames in MEDUSA receive automatically a sequential
number added to the blockname in DXF.

(blockname = grouplabel_sheet_no)

off

Groupnames from MEDUSA are not transferred as blocknames to
DXF. A standardname is used,
MEDUSA_SET_<element_number>_

COLORS

SYNTAX colors [ on / off ]

DESCRIPTION MEDUSA cannot handle colored lines but it can attach colors to
pens. This attachment is saved in the file CODE.BIN.
The command colors controls whether or not MEDDXF uses this
attachment for the translation.

OPTIONS on
The attachment colors to pens is used.
off
The attachment colors to pens is not used.
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CONTEXTCHECK

SYNTAX contextcheck [ on 7/ off ]

DESCRIPTION This switch controls, if a drawing without fitting code and DDL can be

opened. If it is opened all line and text elements, which do not fit to
standard, may be displayed wrong.

If the switch is unset, the default is on.

OPTIONS on

MEDUSA sheets without code and DDL are not opened and a warn-
ing is displayed.

off

The drawing is opened without code and DDL. All line and text ele-
ments, not according to standard may be displayed wrong,

DXFOUT_CHARSET

SYNTAX dxfout_charset [ code ]

DESCRIBPTION Specifies the text code during the conversion from MEDUSA to DXF/
DWG.
The code is entered as text string into the DXF/DWG file.

EXAMPLE DXFOUT_CHARSET ANSI_1250
(Code of Windows East European Latin)

Please note: The following codes are possible:

ANSI 932 - japanese Microsoft Shift-JIS
ANSI 936 - GBK simplified chinese
ANSI 950 - BIGS5 traditional chinese
ANSI 1250 - east european latin

ANSI 1251 - cyrillic

ANSI 1252 - west european latin

ANSI 1253 - greek

ANSI 1255 - hebrew

EUC-JP - UNIX japanese encoding
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DXFPRECISION

SYNTAX dxfprecision [decimal points]

DESCRIPTION The command dxfprecision specifies the number of digits in the
DXF-file.

EXAMPLE MEDDXF> dxfprecision 6

FORCE_DXFOUT_CS

SYNTAX force_dxfout_cs [ on/off ]

DESCRIPTION The switch is directly associated with the dxfout_charset entry
(see above). It controls whether the dxF_charset entry is used.

OPTIONS on

In any case the dxfout_charset entry is used.

off

The dxfout_charset entry is not used. off is default setting.

LTSCALE
SYNTAX Itscale [ factor ]
DESCRIPTION This command describes the size factor (the proportion of drawing
units to line type definition units) for broken lines.
OPTIONS factor
Number bigger than 0.
EXAMPLE Itscale 1

78 © CAD Schroer GmbH



| P =
(CAD)
CAD Schroer

MEDUSA, CADConvert
MedDXF / MedDWG

MEDDXF_DIMENSION

SYNTAX

meddxf_dimension [ dim / geo ]

DESCRIPTION

Using the command meddxf_dimension, you can convert dimen-
sioning as genuine dimensioning (dim) or as a geometrical copy
(geo).

With genuine dimensioning conversion, functionality survives. How-
ever, because AutoCAD and MEDUSA take different approaches to
dimensioning, there may be some differences.

If you convert dimensioning as a geometrical copy, the functionality
is lost. Dimensioning only exists geometrically.

OPTIONS

dim

Dimensioning of the drawing is converted as a genuine dimension-
ing. The functionality of dimensioning is preserved.

geo

Dimensioning of the drawing is converted geometrically. The func-
tionality of dimensioning is lost.

MEDTEXT

SYNTAX

medtext [ filename ]

DESCRIPTION

The command specifies the font filename.

OPTIONS

filename
Contains the filename of the text font in DXF.

EXAMPLE

medtext medtext.shx

MEDTEXT_GDT

SYNTAX medtext_gdt [ Ffilename ]

DESCRIPTION The command specifies the font filename.
The translation to DXF is optimized, so the representation is similar
to MEDUSA representation (for TR texts).

OPTIONS filename
Contains the filename of the text font in DXF.

EXAMPLE medtext _gdt medtext_gdt.shx
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PM5
SYNTAX PM5 [on/off]
DESCRIPTION The command specifies, if PM5 elements are transferred from
MEDUSA to ACAD or not.
OPTIONS on:
PM5 elements are transferred from MEDUSA to ACAD
off:
PM5 elements are not transferred from MEDUSA to ACAD.
off is default setting

OouT
SYNTAX out [ pathname ]
DESCRIPTION The command out specifies the pathname of the output AutoCAD

DXF file.

If you do not specify an output pathname, the output DXF file is cre-
ated in the current directory with a default filename of inputsheet-
name.DXF.

If you specify an output filename that does not end in .DXF a .DXF
suffix is added.

OPTIONS pathname
Full pathname of the output DXF file. The length of the pathname
cannot exceed 256 characters.

EXAMPLE MEDDXF> out /usr/sandy/dxf/elec.dxf
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POLYLINE
SYNTAX polyline [ on / off ]
DESCRIPTION MEDUSA stores objects drawn from lines fundamentally as
polylines. AutoCAD stores these objects as single lines.
With the command polyline you can determine if objects drawn
from lines are stored as polylines or a complex from single lines.
OPTIONS on
Objects drawn from lines are stored in the DXF file as a polyline.
off
Objects drawn from lines are stored in the DXF file as a complex of
single lines
PROJECT
SYNTAX project [ pathname ]
DESCRIPTION Specifies the pathname of a MEDUSA project. This must be a valid
MEDUSA project.
The translator uses DDL.BIN, CODE.BIN and PRIMS.BIN files
located in the project. This allows the interface to detect any custom-
izing you have done to the project and includes the modified or new
elements in the translation process.
OPTIONS pathname
Full pathname of the project file.
EXAMPLE MEDDXF> project /projects/proj_ jebl4d

SPECTEXT_AS_PIC

SYNTAX spectext_as_pic [ on / off ]

DESCRIPTION Special text types (e.g. texts in boxes) are transferred in a block
including text and graphic elements.

OPTIONS on
Transfer as block with text and graphic elements.
off

Default. Transfer as text element.
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SUPERLINEMODE

SYNTAX superlinemode [ line / graphic / both ]
DESCRIPTION With the help of this switch superlines can be translated as graphic
into a DXF Block.
OPTIONS line
Transfer of the Superline as line.
graphic
Transfer of the Superline as a simple vector graphic into a DXF
Block.
both
Transfer of the Superline as graphic and line.

TEXTBOX

SYNTAX textbox [ on/off ]

DESCRIPTION You can optimize the text representation in DXF/DWG.
In the DXF/DWG format, you can fit a text between two points.
These two points are calculated inside MEDUSA.
The original justification is lost, so if you convert this DXF/DWG file
back to MEDUSA all texts will have the justification 22 (= baseline
left bottom).

OPTIONS on
Optimizes by fitting.
off
Keeps the justification if possible.The text representation will be opti-
mized with the texthight.

TEXTHEIGHT_ZERO

SYNTAX textheight _zero [ on/off ]
DESCRIPTION Determines whether texts with height zero are transferred or not.
OPTIONS on

Texts will be transferred.

off

Texts will be not transferred. This is the default.
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UNSCALE

SYNTAX unscale [ on / off ]

DESCRIPTION The command unscale sets the sheet scale and the drawing to 1:1

OPTIONS on

Converts the drawing by using the original sheet scale.
off
sets the sheet scale and the drawing to 1:1.
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LIMITATIONS

Since MEDUSA and DXF are in different CAD formats, some information may not be translated
between them. MEDUSA is designed to save as much information as possible from each of the
two formats, but there are some restrictions. The most important restrictions are described
below.

Raster Transfer

Raster transfer is restricted to projects with the MEDCOLRASTER product.

With the conversion of raster images only rectangular clipping of images and rotation by steps
of 90 degrees is possible. Shearing is not transferred.

DXF/DWG -> MEDUSA

In the current CADConvert version the AutoCAD Revision 2000 DXF element multiline is not
processed. Shapes are not processed.

Pattern hatchings are not exactly transferred into MEDUSA, they will be defined as standard
hatchings.

3D Elements are processed with X and Y values only. 3D volume elements and views are not
processed.

Width of start and end segments of poly lines are not evaluated.
convspace[paper] is not available for list conversion.

convspace[all_paper]is only available in MEDUTIL, but not in the MEDUSA UI.

MEDUSA -> DXF/DWG

Parallel dimension-chains and coordinate dimensions are converted to geometry.
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In AutoCAD version R12 boldness is still unknown, nevertheless it appears in the settings of
line-style mapping. However this column is not analyzed. It is reseverd for future use.

Elements from AutoCAD Inventor

It is not possible to convert elements from AutoCAD Inventor to MEDUSA. This data can only
be displayed with an AutoCAD internal add-on.
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